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Important Notice 
We have done the utmost to make certain that the data that appears on the tax forms 
produced by the Club Tax Printer software is correct as based on the data in your cur-
rent Club Accounting files. Nevertheless, we do not warrant the accuracy or com-
pleteness of the data on the printed tax forms. All responsibility for accuracy and 
completeness rests with your investment club and with the person who handles the 
tax matters for your club. 
 

http://www.iclub.com


1 2008 Club Tax Printer User Guide 

Contents 
Using the 2008 Club Tax Printer ............................................................................1 
System Requirements ............................................................................................1 
Preparing Your Club Data ......................................................................................1 
Installing the Club Tax Printer ...............................................................................2 
Running the Club Tax Printer ................................................................................2 
Registering the Tax Printer ....................................................................................2 
Draft and Final Forms ............................................................................................3 
Entering Your Club Information ............................................................................3 
Generating and Printing Your Tax Forms ...............................................................5 
What You Need to Send to the IRS ........................................................................6 
What You Need to Give to Your Members .............................................................6 
What You Need to Keep for Club Records .............................................................6 
Common Problems and Release Notes ...................................................................6 
Help from ICLUBcentral .......................................................................................7 
About ICLUBcentral Inc. .......................................................................................8 
User License and Support Agreement (ULSA) .......................................................9 
 

Using the 2008 Club Tax Printer  
This Tax Printer program works with data from ICLUBcentral’s Club Accounting 
software, performing certain calculations, and then generating tax forms with these 
calculated values. The program does not alter your original club data stored in the 
Club Accounting software. To properly use this program, you must make sure your 
accounting records are up-to-date and accurate.  

System Requirements 
Use of this software requires at least: 

• A compatible Windows operating system (Windows 2000/XP/Vista). 
• 128 MB of RAM minimum (256 MB recommended). 
• 30 MB of free hard drive space. 
• Adobe Acrobat 6.0 or higher (required to read and display PDF files). The 

program may be downloaded free of charge from http://www.adobe.com. 
• Club Accounting version 3.1 (CA3) or higher. 
• A current Club Accounting Maintenance contract. 

Preparing Your Club Data 
Before generating your tax forms, make sure that your club accounting data is prop-
erly prepared. We recommend that you wait until you have all the necessary data 
and have performed a reconciliation of all partnership accounts before completing 
your taxes. Necessary data includes year-end brokerage and bank statements; 
records of all buys, sells, dividends, interest, and service charges through December 
31, 2008; and Form 1099s issued by your financial institutions. It is likely that you 
will not have this information until mid-February (this is later than last year). Once 

http://www.adobe.com
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you have all the necessary data and the club has conducted their annual audit, close 
out the books for the year: 

1) Launch Club Accounting 3. 
2) Select Tools > Year-end Tasks. Follow the instructions to close your 

books for the year. 

Installing the Club Tax Printer 
There are two installation options, downloading from the Internet or from a CD: 
If you are downloading the program from the Internet: 

• Go to http://www.iclub.com/support/downloads.asp.  
• Click on the appropriate tax printer program. 
• The installation program launches automatically (if you select Open).  
• If you choose not to allow automatic installation, or choose to Save the 

downloaded file to your computer, install the program manually by click-
ing on the 2008 Club Tax Printer Setup icon.  

If you have received a CD: 
• Insert the CD into your computer’s CD-ROM drive. The installation pro-

gram should launch automatically. 

Running the Club Tax Printer 
The Club Accounting Tax Printer is not a separate program. It installs as an add-on 
to Club Accounting 3 (CA3). Simply select Taxes from the menu to run your taxes. 

 
If you have multiple clubs loaded in your CA3 software, each time the Tax Printer 
is launched, you will need to select the club with which you wish to work from a list 
of club names. If you would like to use the Tax Printer to generate tax forms for 
several clubs, you will need to purchase a Tax Printer serial number for each club. 
See http://www.iclub.com for more information on how to purchase additional seri-
al numbers. 

Registering the Tax Printer 
When starting the tax printer for the first time, you will see the registration window. 
You must register your program over the Internet with your Tax Printer serial num-
ber before it is usable. Your Tax Printer serial number is proof that you purchased a 
license to use this program. It is included with your Tax Printer packaging. If you 
purchased the downloadable version of this program, your Tax Printer serial number 
will be provided to you via email. 

http://www.iclub.com/support/downloads.asp
http://www.iclub.com
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Draft and Final Forms 
The Club Tax Printer is released early each year, often before final forms have been 
released by the IRS and the states. When you initially install the program, it may 
display preliminary forms with a “DRAFT” watermark. These draft forms may 
not be used to file a tax return with the IRS or your state. They are provided so 
that you may get a head-start on the preparation of your forms, diagnose any possi-
ble technical problems, and generally ensure that your tax printer and club account-
ing software are working properly. 
The Club Tax Printer has an automatic updater built into the program. Each time 
you start the Club Tax Printer, it will check the Internet to see if any updates are 
available. (You must be connected to the Internet in order for the auto-updater to 
work.) When an update is available, the program will download and automatically 
install the new version. To check the expected release schedule for the IRS and your 
state’s returns, please check http://www.iclub.com regularly through the tax season. 

Entering Your Club Information 
Once you have registered, over the next several screens you will be prompted to 
enter information about your club necessary to generate your club’s tax forms. 
Step 1: 

• Club Address: Enter your club’s legal address as registered with the IRS.  
• Date business started: The date that your club formed as a partnership.  
• Check the Amended Return box only if you are filing an amended return. 
• Type of partnership: Most clubs are formed as general partnerships.  

Step 2:  
• Did any individual or estate own, directly or indirectly, an interest of 50% 

or more in the profit, loss, or capital of the partnership? 
Mark appropriately. Most clubs will leave this unchecked. If your club is a 
family partnership, review the rules for constructive ownership before 
answering this question. 

• Did the partnership file Form 8893, Election of Partnership Level Tax 
Treatment, or an election statement under section 6231(a)(1)(B)(ii) for 
partnership-level tax treatment, that is in effect for this tax year? 
If your club had ten or fewer partners throughout the 2008 tax year (hus-
band and wife count as one partner; no partners being non-resident aliens, a 
C corporation, or the estate of a deceased partner), you may elect to answer 
Yes to this question. If you select yes, Form 8893 will be generated by the 
software (to be filed with your return) and you should enter your designat-
ed TMP information below. (If you previously filed Form 8893 with the 
IRS, check the box, enter your TMP information below but do not file 
8893.) You may also choose not to make this election. See IRS Form 1065 
instructions for more detail. 

If your club had more than ten partners at any time during the 2008 tax 
year (see guidelines above) then your club is already subject to Partnership 

http://www.iclub.com


2008 Club Tax Printer User Guide 4 

Level Tax Treatment. Leave this box unchecked. You may still provide the 
name of your club’s designated TMP below if desired. 
o Name of the Tax Matters Partner (TMP) 
o Identifying number of the TMP (usually a Social Security number). 
o In the upper box enter the street address. 
o In the lower box enter the city or town, state, and ZIP code. 

• Is this partnership a publicly traded partnership as defined in section 469? 
Mark appropriately. Most clubs will leave this unchecked. 

Step 3: 
• Does the partnership satisfy all four of the following conditions? Mark ap-

propriately. Most clubs will check this box. 
a. The partnership's total receipts for the tax year were less than 

$250,000. 
b. The partnership's total assets at the end of the tax year were less 

than $1 million. 
c. Schedules K-1 are filed with the return and furnished to the part-

ners on or before the due date (including extensions) for the part-
nership return. 

d. The partnership is not filing and is not required to file Schedule 
M-3 

• During the tax year, did the partnership have any debt that was cancelled, 
was forgiven, or had the terms modified so as to reduce the principal 
amount of the debt?  Mark appropriately. Most clubs will leave this un-
checked. 

• At any time during the tax year, did the partnership distribute to any part-
ner a tenancy-in-common or other undivided interest in partnership prop-
erty?  Mark appropriately. Most clubs will leave this unchecked. 

• If the partnership is required to file form 8858, Information of Return of 
U.S. Persons with Respect to Foreign Disregarded Entities, enter the num-
ber of Forms 8858.  Mark appropriately. Most clubs will leave this blank, 

Step 4: 
• At any time during the calendar year 2008, did the partnership have an in-

terest in or a signature or other authority over a financial account in a for-
eign country (such as a bank account, securities account or other financial 
account)? See page 20 of the instructions for exceptions and filing re-
quirements for Form TD F 90-22.1. If “Yes” enter the name of the foreign 
country: 
Fill in appropriately. Most clubs will leave this blank.  

• At any time during calendar year 2008, did the partnership have an inter-
est in or a signature or other authority over a financial account in a for-
eign country (such as a bank account, securities account, or other finan-
cial account)?  If "Yes", enter the name of the foreign country: 
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• Does the partnership have any foreign partners?  If "Yes", enter the num-
ber of forms 8805, Foreign Partner's Information Statement of Section 
1446 Withholding Tax, filed for this partnership" 

• Enter the number of Forms 8865, Return of U.S. Persons with Respect to 
Certain Foreign Partnerships, attached to this return: 

IRS Center: 
Investment clubs are generally partnerships, and do NOT send their tax forms to the 
same place as individuals. Choose the appropriate IRS center for your club from the 
drop down list, then select Next. If you do not know where to file, click on the con-
venient Where do I file? button. Please note that the address provided is simply a 
city and a ZIP code.  The post office knows where to route your taxes based on 
that alone. 

Generating and Printing Your Tax Forms 
You are now ready to print your Club Tax Returns. We recommend that you gener-
ate a complete return, and then extra copies of Schedule K-1’s for each member. 
Check the appropriate boxes to print the Form 1065 and Schedule D. 
The scrollable window lists each member active during the Tax year. A Schedule K-
1 prints for each club member highlighted in the list. 

Creating PDF files: Select Finish to generate forms in PDF format and launch 
the Adobe Acrobat Reader. From Adobe Acrobat Reader, you can save a copy 
of the files to your computer or print them directly. 
Printing your tax forms: To print tax forms, click on the printer icon or go to 
the File > Print menu item after you’ve created a PDF file copy of your club’s 
tax return. 
Saving your tax forms: To save your tax forms in PDF format, click on the 
disk icon or go to the File > Save menu item. The files will be saved in 
Adobe’s PDF format. You may read these at anytime using the Acrobat Reader. 

Additional notes: A Tax ID number for each member is required for the club’s tax 
returns to be complete. If the message No Tax ID Entered shows up next to a mem-
ber’s name, that member’s Social Security Number was not entered in Club Ac-
counting. Fill it in by hand after you have printed the appropriate tax form. 
The 1065/K-1 software prints the following forms and schedules: 

• Form 1065: U.S. Partnership Return of Income, pages 1-4. 
• Schedule D (Form 1065): If your club has no capital gains or losses for 

the year, this schedule is unnecessary and will not be printed. There also 
may be supplemental pages printed. 

• Supporting schedules for Schedule K: Partners’ Shares of Income, 
Credits, Deductions, etc. There also may be supplemental pages printed. 

• Schedule K-1 and K-1 Instructions: For each partner. 
• Form 8893: Only if chosen as per Step 2, question 4. 
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Not all pages of Form 1065 and associated schedules will contain data. In most cas-
es, the first page of Form 1065 contains no data except identification, date informa-
tion, and the number of attached Schedule K-1s. 
Note: If required Schedules L, M1, and M2 must be filled out manually. Please see Common 
Problems & Release Notes below. 

What You Need to Send to the IRS 
2008 Club Tax Printer software prints IRS acceptable schedules required for filing 
your club’s tax return. Investment clubs should file with the appropriate IRS service 
center, one copy each of: 

1) Form 1065 (plus Schedule D and any supplementary schedules as necessary. 
If your club has no gains or losses on the year, the tax software will not print 
Schedule D. If this is the case, you do not need to file Schedule D.) 
2) A Schedule K-1 for each member. 

Make sure to send it with confirmation, Registered Mail or Return Receipt 
Requested.  That way, if the IRS calls you years down the road, you have proof 
that you've done your job properly. 

What You Need to Give to Your Members 
Club members (including members who withdrew from the club during the year) 
must be given a copy of their respective Schedule K-1s for use in preparing their 
personal tax returns. This copy is to be kept with their tax records and is not filed 
with the IRS. You must also give each member of your club one copy of the K-1 
instructions, found on page 2 after you generate your complete forms. 

What You Need to Keep for Club Records 
The club should keep a copy of the full Form 1065, Schedule D (if prepared), each 
Schedule K-1, and any additional supporting statements and attachments as part of 
its permanent records. We recommend keeping the electronic PDF files in addition 
to paper copies. 

Common Problems and Release Notes 
• The Club Tax Printer requires registration before the program can be run. 

Registration is done over the Internet from within the registration screen. 
• If the program takes a long time to load your Adobe Acrobat Reader and 

Tax Forms, your computer may lack sufficient memory or free hard drive 
space. Select fewer forms to print faster, then repeat for remaining forms. 

• The Club Tax Printer, in accordance with IRS rules, does not print zeros 
(0) on form spaces where the value is zero. Those fields are left blank.  

• Many fields on the tax forms will be blank and are intended to be blank. 
The same forms your club uses are used by partnerships that own property 
and have payrolls, neither of which applies to your investment club. Re-
lated fields are therefore blank. 
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• Pertinent IRS forms, publications, and instructions are on the CD and in 
the program folder after installation. 

• If your club had assets with a cost basis of $1,000,000 or more, or had in-
come of $250,000 or more, some schedules must be completed manually. 
Clubs having either of these conditions should seek tax advice from a certi-
fied tax preparer. 

• The Club Tax Printer does not support the IRS 754 Election.  
• The Club Tax Printer software uses industry standard Adobe Acrobat soft-

ware to generate your tax forms. A free copy of Acrobat Reader installs 
with the tax program, or can be downloaded from http://www.adobe.com.  

• The Club Tax Printer will correctly allocate qualifying and non-qualifying 
dividends ONLY if all of the following conditions are met: 
• All dividends linked to securities are entered properly in Club Ac-

counting  
• Ex-dividend dates are entered for all common stock dividends in CA  
• REITs, mutual funds, and “other” (Limited and Publicly Traded Part-

nerships, etc.) securities are correctly identified. 

Help from ICLUBcentral 
Technical Support is available on our web site at http://www.iclub.com/support/. 
You may ask specific questions via our web form and review the Frequently Asked 
Questions section of the web site as well.  

Requesting Technical Support: 
 

To our Treasurers, 
 

Each year, your club’s members look to you to make sure their taxes 
are filed in time. And each year, from December to March, ICLUBcen-
tral’s call volumes triple. We bring in extra help, update the FAQs, and 
give it our all to answer your questions. Your patience during this time 
is appreciated. Here’s looking forward to a successful tax season! 
 

Daniel R. Abraham 
VP of Customer Care, ICLUBcentral Inc. 
 

If you cannot solve your problem using online help, the most efficient way to con-
tact an ICLUBcentral Technical Support Representative is to use our web help 
forms located at http://www.iclub.com/support/. Our experts will then easily be able 
to retrieve and reply to your question or problem quickly and efficiently.  

Answers to questions about installation of the Club Tax Printer are included with 
your purchase of the software. Questions about club accounting principles, tax is-
sues, and the Club Accounting software are covered by your Maintenance Agree-
ment. To receive full coverage, you must purchase Accounting Software Mainten-
ance and renew it annually.  

Use the guide to help our experts quickly answer your questions. Write down the 
precise wording of any error message displayed when you have a problem, includ-
ing the names of any files mentioned in the message. Be familiar with: 

http://www.adobe.com
http://www.iclub.com/support
http://www.iclub.com/support/


2008 Club Tax Printer User Guide 8 

• The version of Windows you are using. 
• The make, model and amount of memory (RAM) on your computer.  
• The make and model printer if you have a question regarding printing. 
• Note your Club Tax Printer serial number and purchase/installation date. 

About ICLUBcentral Inc. 
ICLUBcentral Inc., located in Cambridge, MA, is a global leader in the develop-
ment of software tools for investment clubs. We have been making club accounting 
and club tax software since 1989, and our products are used by more investment 
clubs than any other in the world. 

Besides Club Accounting 3 and Club Accounting Online at myiclub.com, IC-
LUBcentral also produces software programs for stock analysis, including Inves-
tor’s Toolkit, Stock Analyst, Stock Prospector, and Take Stock; newsletters such 
as the market-beating Investor Advisory Service (http://www.iclub.com/ias/); and a 
complete suite of online tools, data, and community for investors, StockCen-
tral.com. For details and special offers for you and your investment club members, 
please visit http://www.iclub.com. 
  

http://www.iclub.com/ias/
http://www.iclub.com
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User License and Support Agreement (ULSA)  
Applicable to the 2008 Club Tax Printer. Use of this product is governed by terms of a User License and support 
Agreement or ULSA. THIS LICENSE AND SUPPORT AGREEMENT (THE “AGREEMENT”) IS A LEGAL CON-
TRACT BETWEEN YOUR INVESTMENT CLUB OR YOU IN YOUR INDIVIDUAL CAPACITY, AS THE CASE 
MAY BE AS INDICATED IN THE PRECEDING PARAGRAPH (COLLECTIVELY, “YOU”) AND ICLUBCEN-
TRAL INC. (“ICLUBCENTRAL”). BY CLICKING ON “ACCEPT” WHEN YOU INSTALL THE SOFTWARE, 
YOU ARE AGREEING TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT, INCLUD-
ING WITHOUT LIMITATION THE CUSTOMER SUPPORT PROVISIONS SET OUT BELOW. IF YOU DO NOT 
AGREE TO SUCH TERMS AND CONDITIONS, YOU MUST PROMPTLY RETURN THE SOFTWARE ICLUB-
CENTRAL OR ITS SOFTWARE DISTRIBUTOR, IN ORDER TO RECEIVE A FULL REFUND OF THE LICENSE 
AND CUSTOMER SUPPORT FEES THAT YOU HAVE PAID. If You should have any difficulty in obtaining such 
refund, please contact ICLUBcentral at 1430 Massachusetts Ave, 3rd Floor, Cambridge, MA 02138. 
THE ENCLOSED COPY OF THE 2008 CLUB TAX PRINTER, INCLUSIVE OF ALL ADD-ONS AND FUTURE 
RELEASES, (the “SOFTWARE”), AND THE RELATED DOCUMENTATION, INCLUSIVE OF ALL FUTURE 
RELEASES (the “DOCUMENTATION”), ARE EACH LICENSED TO YOU WITH A NON-EXCLUSIVE AND 
NON-TRANSFERABLE RIGHT, EXCEPT AS ALLOWED BELOW UNDER ‘PERMITTED USES’, TO USE ONLY 
UNDER THE FOLLOWING TERMS AND CONDITIONS: 
PERMITTED USES: You MAY: Install the Software on a storage device in Your computer, as set forth in the instruc-
tions contained in the Documentation. Note: The Software has been designed to only allow it to be used for a single 
individual in Your investment club on a single personal computer. 
NON-PERMITTED USES: You MAY NOT: 

• Make any copies of the Software. 
• Make any copies of the Documentation. 
• Disclose, rent, license, sublicense, lease, sell, lend, disseminate or otherwise distribute the Software or the 

Documentation.  
• Network the Software or otherwise use it on more than one computer or computer terminal at the same 

time. 
• Use the Software to conduct a service bureau, application service provider (“ASP”) business or similar 

business for the benefit of third parties. 
• Transfer Your rights under this Agreement. 
• Alter, enhance, supplement, create derivative work therefrom, translate, decompile, disassemble, reverse 

engineer or otherwise reduce the Software to human readable form. 
• Remove or obscure the copyright and trademark notice on the label of the storage medium containing the 

Software or in the Documentation. 
TERMINATION/DURATION: This Agreement and Your license to use the Software and the Documentation will 
automatically terminate without notice from ICLUBcentral and without any pro rata abatement of the license and cus-
tomer support fees You have paid if You fail to comply with any term or condition of this Agreement or upon your 
giving written notice of termination to ICLUBcentral. 
This Agreement is effective from the day upon which You indicate acceptance of this Agreement. In order to be granted 
license to use this Software, you must register this Software fully and accurately with ICLUBcentral and receive a valid 
confirmation of registration from ICLUBcentral. The license then granted will continue until either You terminate this 
Agreement by giving written notice of termination to ICLUBcentral; or this Agreement is terminated by ICLUBcentral, 
as provided in the immediately preceding paragraph. 
CUSTOMER SUPPORT PROVISIONS: Included in the total fee that You have paid for the Software and the Docu-
mentation is an amount that covers limited customer support services as described in this Agreement (the “Customer 
Support Services”). ICLUBcentral will provide limited Customer Support Services for the length of time described 
below in the section headed ‘Support Termination/Duration’ during the term of this Agreement.   
CUSTOMER SUPPORT OBLIGATIONS OF ICLUBCENTRAL: Provide customer support for the Software only 
if (i) You have performed the online Product Registration as provided by ICLUBcentral in order to register the Soft-
ware; and (ii) Your copy of the Software is identified with a valid serial number, and Registration Code. 
Investigate and identify any problem reported by You to ICLUBcentral that is related to the then current release of the 
Software, and correct or provide within an appropriate time, as determined by ICLUBcentral, either (i) a workaround for 
any programming error in the then current release of the Software which You have identified, provided that the error is 
directly attributable to ICLUBcentral, or (ii) a resolution to the problem which You have identified (collectively the 
“Code Correction Services”). 

RELATED OBLIGATIONS OF END-USER:  
• Use only the then current release of the Software during the term of this Agreement. 
• In the event of (i) a problem with the Software that results in either a system crash or loop; or (ii) a situa-

tion where You can reasonably demonstrate that the Software produces an erroneous arithmetic result that 
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is not a function of incorrect or improper input data, then You must submit to ICLUBcentral a written re-
port of all input and keystrokes to the Software giving rise to the problem. 

SUPPORT TERMINATION/DURATION: Answers to questions about installation of the Club Tax Printer are in-
cluded with your purchase of the software. Questions about club accounting principles, tax issues, and the Club Ac-
counting software are covered by your Club Accounting Maintenance Agreement. To receive full Customer Support 
coverage, you must purchase a Club Accounting Maintenance Agreement and renew it annually.   
LIMITED WARRANTY: ICLUBcentral does not have control over the conditions under which You use the Software 
and does not and cannot warrant the performance or results that may be obtained by its use. However, ICLUBcentral 
warrants that the Software will perform substantially in accordance with the Documentation for a period of ninety (90) 
days from the date the product was shipped to You, provided that the Software is used on the computer equipment, 
operating system and in the environment for which it was designed and configured. Your sole remedy and ICLUBcen-
tral ‘s exclusive liability under the foregoing limited warranty will be the furnishing by ICLUBcentral, within a reasona-
ble period of time and without charge, of the Customer Support Services pursuant to the Customer Support Services 
provisions of this Agreement. To bring a claim under this limited warranty, You should contact Support Department at 
ICLUBcentral, 1430 Massachusetts Ave, 3rd Floor, Cambridge, MA 02138 to obtain information on warranty perfor-
mance; You must be given a Return Authorization Number by ICLUBcentral before returning the Software to ICLUB-
central. Some jurisdictions do not allow the exclusion or limitation of relief, incidental or consequential damages, so the 
above limitation or exclusion may not apply to You. 
Because computer programs are inherently complex, You are advised to always verify Your work and periodically (after 
each use) back up the data You have created with the Software. 
ICLUBcentral does not warrant that any of the Software, the Documentation or Customer Support Services to be pro-
vided pursuant to this Agreement will meet Your requirements. The only warranty made with respect to the Software is 
the limited warranty set forth in this Agreement. 
EXCEPT AS SO SPECIFICALLY PROVIDED ABOVE IN THE IMMEDIATELY PRECEDING PARAGRAPH, 
THERE ARE NO WARRANTIES, REPRESENTATIONS, OR CONDITIONS MADE BY ICLUBCENTRAL OR 
ANY OTHER PERSON INVOLVED IN THE CREATION, PRODUCTION OR DISTRIBUTION OF THE SOFT-
WARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES, EITHER EXPRESS OR IMPLIED, 
WITH RESPECT TO THE SOFTWARE, THE DOCUMENTATION, ANY RELEASES THERETO, OR THE CUS-
TOMER SUPPORT SERVICES INCLUDING THEIR RESPECTIVE QUALITY, PERFORMANCE, MERCHAN-
TABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. Notwithstanding the above, 
where applicable, if You qualify as a “consumer” under the Magnuson-Moss Warranty Act, then You may be entitled to 
any implied warranties allowed by law for the period of the express warranty as set forth above. Some states do not 
allow limitations on how long an implied warranty lasts, so the above limitation may not apply to You. This warranty 
gives You specific legal rights, and You may also have other rights which vary from state to state. 
LIMITATIONS OF LIABILITY; INDEMNIFICATION: NEITHER ICLUBCENTRAL NOR ANY OTHER PER-
SON INVOLVED IN THE CREATION, PRODUCTION, DISTRIBUTION OR SUPPORT OF THE SOFTWARE, 
THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES WILL BE LIABLE TO YOU OR ANY 
THIRD PARTY ARISING OUT OF THIS AGREEMENT AND/OR YOUR USE OF OR INABILITY TO USE THE 
SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES, REGARDLESS OF THE 
FORM OF THE CLAIM OR ACTION, THAT EXCEEDS THE PORTION OF THE FEE YOU HAVE PAID FOR 
THE SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES, AS THE CASE MAY 
BE. 
NEITHER ICLUBCENTRAL NOR ANY OTHER PERSON INVOLVED IN THE CREATION, PRODUCTION, OR 
DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES 
WILL BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, 
EXEMPLARY DAMAGES OR OTHER INDIRECT DAMAGES OR LOSS OF PROFITS, LOSS OF DATA OR 
LOSS OF USE DAMAGES ARISING OUT OF THIS AGREEMENT; AND/OR 
THE MANUFACTURE, SALE, SUPPLYING OR FAILURE OR DELAY IN SUPPLYING OF THE SOFTWARE, 
THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES RELATED THERETO, EVEN IF ICLUB-
CENTRAL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
Some jurisdictions do not allow the exclusion or limitation of special, incidental, consequential, indirect or exemplary 
damages, or the limitation of liability to specified amounts, so the above limitations or exclusions may not apply to You. 
YOU AGREE TO INDEMNIFY AND HOLD ICLUBCENTRAL AND ALL OF THE PERSONS INVOLVED IN 
THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION AND 
THE CUSTOMER SUPPORT SERVICES HARMLESS FROM CLAIMS AND DAMAGES OF ANY TYPE WHAT-
SOEVER ARISING FROM ANY THIRD PARTY AS A RESULT OF YOUR USE OF THE OUTPUT FROM, 
AND/OR YOUR INABILITY TO USE THE SOFTWARE OR AS A RESULT OF ANY CUSTOMER SUPPORT 
SERVICES PROVIDED OR TO BE PROVIDED UNDER THIS AGREEMENT. 
GEOGRAPHIC LIMITATION: ICLUBcentral Customer Support Services cannot be provided at the same level to 
customers outside of the continental United States, Hawaii and Alaska. ICLUBcentral’s website is available to custom-
ers anywhere in the world. Email support will be provided, on a best efforts basis, to foreign customers, but only in 
English. It is understood that the ICLUBcentral products have been developed for the U.S. marketplace. 
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U.S. GOVERNMENT RESTRICTED RIGHTS: The Software and Documentation are “commercial computer soft-
ware” or “commercial computer software documentation.” Absent a written agreement to the contrary, the U.S. Gov-
ernment’s rights with respect to such Software or Documentation are limited by the terms of this Agreement, pursuant to 
FAR ‘ 12.212(a) and/or DFARS ‘ 227.7202-1(a), as applicable. 
GENERAL PROVISIONS: The Software, the Documentation, and all releases thereto are licensed to You by ICLUB-
central, and are protected by United States copyright laws and by international treaty provisions. Title to the Software 
and the Documentation, and patents, copyrights and all other property rights applicable thereto, shall at all times remain 
solely and exclusively with ICLUBcentral and its licensors, and You shall not take any action inconsistent with such 
title. Therefore, except for the permitted right to make one (1) back up copy of the Software, You must treat the Soft-
ware and the Documentation like any other copyrightable material and are precluded by law from making any copies of 
them. Any rights not expressly granted herein are reserved to ICLUBcentral and its licensors. 
The rights and obligations under this Agreement will be governed by, and any arbitration or court action hereunder shall 
apply, the laws of the Commonwealth of Massachusetts, excluding its conflicts of law rules, and will not be governed by 
the United Nations Convention of Contracts for the International Sale of Goods, the 1974 Convention on the Limitation 
Period in the International Sale of Goods (the “1974 Convention”) and the Protocol amending the 1974 Convention, 
done at Vienna April 11, 1980, the application of which is expressly excluded.  
Any dispute, controversy or claim arising out of or relating to this Agreement or to a breach hereof, including its inter-
pretation, performance or termination, shall be resolved in the courts of Massachusetts.  
The parties irrevocably submit to the exclusive jurisdiction of the federal and state courts of Massachusetts. Notwith-
standing anything contained in this paragraph to the contrary, ICLUBcentral shall have the right to institute judicial 
proceedings against You or anyone acting by, through or under You, in order to enforce ICLUBcentral’s rights hereund-
er through reformation of contract, specific performance, injunction or similar equitable relief. 
If any term or condition in this Agreement is invalid or unenforceable in any respect under any applicable statute or rule 
of law, then such term or condition is modified to have the most nearly similar permissible economic or other effect in 
order to be valid and enforceable under such applicable statute or rule of law. 
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT, AND AGREE TO BE 
BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT THIS AGREEMENT IS THE 
COMPLETE AND EXCLUSIVE STATEMENT OF THE RELATIONSHIP BETWEEN YOU AND ICLUBCEN-
TRAL, AND SUPERSEDES ALL PRIOR OR CONTEMPORANEOUS PROPOSALS, ORAL OR WRITTEN, UN-
DERSTANDINGS, REPRESENTATIONS, CONDITIONS, WARRANTIES, AND ALL OTHER COMMUNICA-
TIONS BETWEEN YOU AND ICLUBCENTRAL OR BETWEEN YOU ANY OTHER PERSON INVOLVED IN 
THE CREATION, PRODUCTION OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE 
CUSTOMER SUPPORT SERVICES; AND THIS AGREEMENT MAY NOT BE EXPLAINED OR SUPPLE-
MENTED BY CUSTOM OR USAGE OF TRADE OR ANY PRIOR COURSE OF DEALINGS BETWEEN YOU 
AND ANY OTHER PERSON. 
IF THERE ARE ANY CONCERNS REGARDING THIS AGREEMENT, PLEASE CONTACT: ICLUBCENTRAL, 
1430 MASSACHUSETTS AVE, 3rd FLOOR, CAMBRIDGE, MA 02138. 


